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 1
I n t r o d u c t i o n
Welcome to the Material Library. This optional package extends the COMSOL 
Multiphysics® modeling environment with data for more than 2500 materials. The 
entry for a given material can contain data for as many as 27 different material 
properties with a focus on elastic and thermal properties. Each of these material 
properties is described as a function of some variable, typically temperature. In all, 
the Material Library contains a total of almost 20,000 property functions.

Although the data is specified in the SI unit system, COMSOL Multiphysics can 
automatically convert it to other unit systems.

Most of the properties are available as functions of temperature, which makes the 
Material Library ideal for multiphysics couplings such as electrical-thermal analysis 
and structural-thermal analysis. In some cases, data is given for a material’s solid, 
liquid, and vapor phases.

The properties are analytic functions over a given interval of the argument. 
COMSOL Multiphysics makes use of smoothing to interpolate the values of the 
properties between different intervals. You can choose the smoothing settings in 
order to obtain continuous first and second derivatives of the property functions.

It is possible to copy the materials to a user-defined library where you can add and 
edit their properties. You can also plot and inspect the definition of a function.
 1



2 |  C H A P T E R  
The Material Library stores the material data in groups and subgroups, thus making it 
easy to find the material you are looking for. In addition, a flexible search feature lets 
you look for materials by name, UNS number, or DIN number. A reference provides 
the source of the function that defines each property.

The material property data in the Material Library is based on the Material Property 
Database (MPDB) from JAHM Software, Inc.

Typographical Conventions

All COMSOL manuals use a set of consistent typographical conventions that should 
make it easy for you to follow the discussion, realize what you can expect to see on the 
screen, and know which data you must enter into various data-entry fields. In 
particular, you should be aware of these conventions:

• A boldface font of the shown size and style indicates that the given word(s) appear 
exactly that way on the COMSOL graphical user interface (for toolbar buttons in 
the corresponding tooltip). For instance, we often refer to the Model Navigator, 
which is the window that appears when you start a new modeling session in 
COMSOL; the corresponding window on the screen has the title Model Navigator. 
As another example, the instructions might say to click the Multiphysics button, and 
the boldface font indicates that you can expect to see a button with that exact label 
on the COMSOL user interface.

• The names of other items on the graphical user interface that do not have direct 
labels contain a leading uppercase letter. For instance, we often refer to the Draw 
toolbar; this vertical bar containing many icons appears on the left side of the user 
interface during geometry modeling. However, nowhere on the screen will you see 
the term “Draw” referring to this toolbar (if it were on the screen, we would print 
it in this manual as the Draw menu).

• The symbol > indicates a menu item or an item in a folder in the Model Navigator. 
For example, Physics>Equation System>Subdomain Settings is equivalent to: On the 
Physics menu, point to Equation System and then click Subdomain Settings. 
COMSOL Multiphysics>Heat Transfer>Conduction means: Open the COMSOL 

Multiphysics folder, open the Heat Transfer folder, and select Conduction.
1 :  I N T R O D U C T I O N



• A Code (monospace) font indicates keyboard entries in the user interface. You might 
see an instruction such as “Type 1.25 in the Current density edit field.” The 
monospace font also indicates COMSOL Script codes.

• An italic font indicates the introduction of important terminology. Expect to find 
an explanation in the same paragraph or in the Glossary. The names of books in the 
COMSOL documentation set also appear using an italic font.
 |  3
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Ove r v i ew o f  t h e  Ma t e r i a l  L i b r a r y

The Material Library incorporates mechanical, thermal, and electrical properties 
primarily for solid materials. It is organized in groups and subgroups according to the 
components of the material or its application. These groups and subgroups are 
contained in corresponding folders in the user interface as outlined here:

FOLDER SUBFOLDERS NUMBER OF 
MATERIALS

Elements - 97

Fe and Ni Alloys Iron Alloys 231

Nickel Alloys 117

Al and Cu Alloys Aluminum Alloys 104

Copper Alloys 84

Mg and Ti Alloys Magnesium Alloys 32

Titanium Alloys 19

Oxides Simple Oxides 86

Complex Oxides 206

Carbides, Cermets, and Tool Steels Carbides 39

Cermets 16

Tool Steels 51

Carbons and Thermal Insulators Carbons 24

Thermal Insulators 29

Intermetallics, TBC, and Refractory Metals Intermetallics & TBC 
(thermal barrier coatings)

93

Refractory Metal Alloys 84

Polyamides and Polyesters Nylons and Polyamides 88

Polyethers and Polyesters 8

Acetal, PVDF, and EVA Acetal Resins 20

PVDF (polyvinylidene 
fluoride)

9

EVA (ethylene-vinyl 
Acetate)

12

Elastomers and epoxies Miscellaneous Polymers 25

Epoxies 25
1 :  I N T R O D U C T I O N



Misc. Polymers and Polymer Composites Polymer Composites 21

Elastomers 7

Minerals, Rock, Soil, and Woods Minerals, Rocks, and Soils 70

Woods 18

Polypropylenes and PET Polypropylenes 7

PET Compounds 21

Controlled Expansion and Thermocouple 
Alloys

Controlled Expansion 
Alloys

33

Thermocouple Alloys 5

Semiconductors, Optical, and Other 
Materials

Semiconductors and 
Optical Materials

106

Other Materials 27

Solders, dental, and Co Alloys Solders, Low-Melting, and 
Dental Materials

35

Cobalt Alloys 19

Resistance and Magnetic Alloys Resistance Alloys 49

Magnetic Alloys 25

Metal-Matrix and Ceramic-Matrix 
Composites

Metal-Matrix Composites 23

Ceramic-Matrix 
Composites

63

Salts, Fuel-cell, Battery, and Electroceramic 
Materials

Salts 30

Fuel-cell, Battery, and 
Electroceramic Materials

117

Silicides and Borides Silicides 57

Borides 38

Glasses, Metallic Glasses, Nitrides, and 
Beryllides

Glasses and Metallic 
Glasses

122

Nitrides and Beryllides 21

Cast Irons and Mold Materials Cast Iron 116

Mold Materials 15

FOLDER SUBFOLDERS NUMBER OF 
MATERIALS
O V E R V I E W  O F  T H E  M A T E R I A L  L I B R A R Y  |  5



6 |  C H A P T E R  
Each material can have at most 27 properties defined, each of which is available as a 
function of temperature or another appropriate argument. The following table lists 
these property functions:

PROPERTY NAME DESCRIPTION SI UNIT ARGUMENT 

dL Linear expansion - Temperature

CTE Instantaneous coefficient of 
thermal expansion

1/K Temperature

alpha Coefficient of thermal expansion 1/K Temperature

k Thermal conductivity W/(m·K) Temperature

HC Molar heat capacity J/(mol·K) Temperature

C Heat capacity J/(kg·K) Temperature

eta Dynamic viscosity Pa·s Temperature

TD Thermal diffusivity m2/s Temperature

VP Vapor pressure Pa Temperature

E Young’s modulus Pa Temperature

kappa Initial bulk modulus Pa Temperature

mu Initial shear modulus Pa Temperature

nu Poisson’s ratio - Temperature

res Electric resistivity ohm·m Temperature

sigma Electric conductivity S/m Temperature

epsilon Emissivity - Temperature

nemiss Normal total emissivity - Temperature

Syt Tensile strength Pa Temperature

Sys Yield strength level Pa Temperature

elong Elongation - Temperature

rho Density kg/m3 Temperature

SR Stress rupture Pa Time

CS Creep strength Pa Time

FSN Fatigue S-N curve Pa Number of 
cycles

mur Relative permeability - Norm of H field

normfB Nonlinear magnetic flux density, 
norm

T Norm of H field

normfH Nonlinear magnetic field, norm A/m Norm of B field
1 :  I N T R O D U C T I O N



Qu i c k  S t a r t

To access the Material Library, open the Materials/Coefficients Library dialog box.

1 Go to the Options menu and select Materials/Coefficients Library.

The Material Library appears as an additional node in the Materials tree, just beneath 
the Model node listing the materials available in your current model. You can browse 
the different material groups to find the desired one, for example Lithium in the 
nearby figure.

2 Double-click on Elements (or click the plus sign to the left of Elements) to see all the 
elements, then select Lithium.

You can review all the properties defined for Lithium in the Material properties area. 
For example, the function representing its thermal conductivity, k, appears in the 
Value/Expression column on the Thermal and All pages of the table:

k_solid_1(T[1/K])[W/(m*K)].

k_solid_1 is defined as a continuous and piecewise analytic function of its 
argument. This argument must be the numeric value of the temperature, T, when 
expressed in the SI unit kelvin; the conversion factor [1/K] extracts this numeric 
Q U I C K  S T A R T  |  7
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value from the temperature variable, T, independently of which base unit system you 
are using. The resulting numeric function value, k_solid_1(T[1/K]), is the 
thermal conductivity expressed in the SI unit W/(m·K); appending [W/(m*K)] to 
the function value thus gives the complete, dimensionally correct expression for the 
thermal conductivity.

Note: The unit conversion factors appear as a result of how the material property 
functions are defined, producing expressions that are independent of the choice of 
unit system. Thus, no matter what the current base unit system setting in your model 
is, you do not need to alter these factors.

You incorporate a material into a model using the following procedure:

1 Click the Copy button beneath the Materials tree to copy Lithium.

2 Click on the Model node (the top node in the Materials tree) and click the Paste 
button.

Note that pasting a material transfers only the properties of one phase, orientation, or 
condition into the model.
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Once you have incorporated a material into a model, you can access it from the 
different physics settings dialog boxes in the user interface. The following figure shows 
the Subdomain Settings dialog box for the Heat Transfer by Conduction application 
mode. Here you can select Lithium from the Library material list.

The Subdomain Settings dialog box for the Heat Transfer by Conduction application 
mode where Lithium is selected from the Library Material list.

Note that you can also open the Materials/Coefficients Library dialog box by clicking the 
Load button in the Subdomain Settings dialog box shown in the previous figure. When 
you select a material through this procedure, the Materials/Coefficients Library dialog 
box opens in read-only mode.
Q U I C K  S T A R T  |  9
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 2
U s i n g  t h e  M a t e r i a l  L i b r a r y
This chapter provides a detailed description of how to use the Material Library. 
This optional product adds the Material Library node to the Materials tree in the 
Materials/Coefficients Library dialog box, giving you access to more than 2500 
materials with their corresponding 20,000 property functions.

This discussion guides you through the process of selecting a material, adding it to 
a model, editing and adding properties, creating your own material library, and 
using material library properties in COMSOL Multiphysics models. The chapter 
ends by describing the material properties in detail.
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Work i n g  w i t h  t h e  Ma t e r i a l  L i b r a r y

You can access the Material Library in two ways: 

• Through the Materials/Coefficients Library dialog box, which you open from the 
Options menu in COMSOL Multiphysics.

• Through the Load library material button in the Subdomain Settings dialog box in an 
application mode. This opens the Material Library in read-only mode.

When using the Material Library, you typically work through the following steps:

1 Select or search for a specific material or material property

2 Review the selected properties with respect to the conditions in the model

3 Add materials to models and create a custom library

4 Edit or add property functions in a model or library

5 Include properties from a library in the physics settings of your models

You can perform Steps 1 to 4 from the Materials/Coefficients Library dialog box (see the 
following figure). A glance at it gives you a hint about the steps just mentioned.
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For the first step, start with the Materials list, which groups materials in an intuitive 
fashion. In addition, a Search button makes it possible to search materials by name, 
UNS (Unified Numbering System) number, or DIN (Deutsches Institut für Normung 
e.V., the German Institute for Standardization) number. Once you have selected a 
material, you can search for specific properties organized in several groups, which you 
access by clicking the Elastic, Electric, Fluid, Piezoelectric, or Thermal tabs.

Next, review material properties. For this step, the Plot button at the bottom of the 
dialog box graphs a property over the relevant temperature range. The nearby 
Functions button gives you access to the corresponding analytic function expressions 
and intervals of validity. The More Info button provides information about the source 
of the material property consisting of a literature reference, the material’s composition, 
and the conditions for the property function’s estimation or measurement.

You can then add materials to models or create a custom library through the Copy, 
Paste, and Add Library buttons. The New button makes it possible to define materials 
from scratch.

Once you have added a material to a library or a model, you can edit its properties or 
add new properties. To do so click the Functions button. In the case where you need 
to enhance the Material Library with a new property function, go to the Materials/

Coefficients Library dialog box and type the function name in the Value/Expression 
column in the relevant Quantity row.

The following discussion presents several examples how to use the Material Library 
according to the five steps listed above. These examples assume that you have opened 
COMSOL Multiphysics using, in this case, the Conductive Media DC application 
mode.

Selecting and Searching the Material Library

Even though the Material Library is organized in an intuitive fashion with folders and 
subfolders, the search function can still be an efficient tool when you know a material’s 
name, UNS number, or DIN number. Note that the search engine examines only the 
material’s name string. 

Assume that you are looking for a shape memory alloy. You can search for materials 
with the word “shape” or “memory” in their name in this way:

1 From the Options menu open the Materials/Coefficients Library dialog box.

2 Select the Material Library node in the Materials tree.
W O R K I N G  W I T H  T H E  M A T E R I A L  L I B R A R Y  |  13
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3 Select Name from the Search for list.

4 Enter shape memory in the Search string edit field.

5 Click the Search button. All materials meeting the search criteria are listed at the 
Search result node, in this case one material: a Ti-Ni shape memory alloy.
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6 Click the More Info button. This displays some general information about the 
material. Click Close to close just the Material/Property Information dialog box.

By clicking the Go To button when a material in the Search node is selected you move 
from the search tree to the node where the material is organized. Use this to find 
similar materials of the same group.

Reviewing Material Properties

Assume that you have found the desired material. You can then quickly list its property 
functions:
W O R K I N G  W I T H  T H E  M A T E R I A L  L I B R A R Y  |  15
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1 With the All page displayed, select the Hide undefined properties check box at the 
bottom of the dialog box.

The only property functions available for this material are the Young’s modulus and 
the density in the solid phase (the material can only be solid in this specific case). 
You can also select the Enable individual settings check box to list all properties 
regardless of phase, orientation, or condition. Ti-Ni (shape memory) properties are 
available only in one orientation or condition, so this procedure does not change 
this particular list.

Proceed by reviewing the Young’s modulus for the material.

2 Click the Young’s modulus row on the All page.
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3 Click the More Info button and examine the resulting dialog box. 

In addition to the material information, you can review the property information 
including references and notes about the evaluation and measurements of this 
specific property.

4 Click Close.

Continue by reviewing the property functions.
W O R K I N G  W I T H  T H E  M A T E R I A L  L I B R A R Y  |  17
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5 Click the Functions button.

The Functions dialog box displays the expressions used in the different intervals for 
the Argument, which here is temperature, T. Note that a different polynomial defines 
each interval. The coefficients for the terms in the polynomial are entered in pairs, 
where the first term denotes the order and the second term represents the 
coefficient. For example, the pair 0 8.50911E10 specifies a constant (order 0) with 
the value 8.50911E10; the next pair, 1 -8.5221E7, specifies the coefficient for the 
linear term (order 1); and so on, defining the polynomial

The xstart and xend rows define the intervals for the functions.

6 Click Cancel to close the Functions dialog box.

Next plot the Young’s modulus over all intervals for which it is defined.

8.50911·1010 8.5221·107T– …+
 2 :  U S I N G  T H E  M A T E R I A L  L I B R A R Y



7 Click the Plot button. This plot then appears in a separate figure window:

Adding Materials to Models and Creating Your Own Library

Once you have selected a material and reviewed its properties, you can add it to the 
current model and include it in a custom material library. There is a good reason for 
creating your own library, specifically, the ability to add and change property functions. 
In contrast, the Material Library and the Material/Coefficients files included in the 
basic package or any of the optional modules contain read-only properties and 
materials.

Start by adding the selected material, Ti-Ni (shape memory), to the model.

1 Select the Materials/Coefficients Library dialog box.

2 Go to the Materials list and verify that Ti-Ni (shape memory) is still selected.

3 Click Copy.

4 Click the Model node in the Materials list.
W O R K I N G  W I T H  T H E  M A T E R I A L  L I B R A R Y  |  19
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5 Click Paste.

If you need only the material’s Young’s modulus and density, close the dialog box 
and continue modeling. However, assume that you later want to edit the material 
properties or add new property functions to this material. You can then save the 
material in a custom library for later manipulation of its properties:

6 Click the Add Library button.

7 Enter my_own_lib in the Name edit field, click OK.

8 Select the new my_own_lib node in the Materials list.

9 Click Paste.

An alternative is to store your edited material in the User Defined Materials library 
shipped with COMSOL Multiphysics. 

Editing and Adding Property Functions

Continuing on the previous discussion, edit one of the material’s property functions. 
For example, for the Young’s modulus change the lower range of the temperature 
interval from 100 K to 90 K:

1 Click the Young’s modulus row in the Materials/Coefficients Library dialog box.
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2 Click the Functions button.

3 Select E in the Defined functions list.

4 Click the first row in the xstart column.

5 Replace 100 with 90 in the corresponding cell.

6 Click OK.

7 In the Materials/Coefficients Library dialog box, click the Young’s modulus row if it is 
not already selected.

8 Click Plot.

The resulting plot appears in a new figure window. You can compare this to the original 
property function that should still be displayed in the Figure 1 window. 

Note that this is a convenient way of changing material properties in an existing model. 
Assume that you have used the material Ti-Ni (shape memory) in several 
subdomains. By applying a change to the property function, you change the property 
of this material in all subdomains and application modes referring to the material 
without the need to open the Subdomain Settings dialog box.

Continue by adding a new property to this material, for example, electric conductivity.

1 Click the Materials/Coefficients Library dialog box.

2 Click the Function button.

3 Click the New button below the Defined functions list.
W O R K I N G  W I T H  T H E  M A T E R I A L  L I B R A R Y  |  21
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4 Type sigma in the Function name edit field.

5 Click the Interpolation button.

6 Click OK.

7 While in the Functions dialog box find the Interpolation method list and select Linear.

8 Type 100 in the first row in the x column, then enter 1.3e6 in the first row in the 
f(x) column.

9 Type 350 in the second row in the x column, then enter 1.2e6 in the corresponding 
f(x) column.

10 Click OK.

11 Return to the Materials/Coefficients Library dialog box.

12 In the Material properties area click the Electric tab.

13 Clear the Hide undefined properties check box.
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14 Click in the sigma row for the electric conductivity.

15 Type sigma(T[1/K])[S/m] in the corresponding Value/Expression edit field. This 
gives access to the already defined function sigma with the argument T 
automatically transformed to kelvin and the function value given in S/m.

16 Click Apply.

17 In the Material properties area click the All tab.
W O R K I N G  W I T H  T H E  M A T E R I A L  L I B R A R Y  |  23
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18 Select the Hide undefined properties check box. You have three defined properties.

19 Click the row for Electric conductivity.

20 Click Plot.

21 Type 100 and 350 in the Range edit fields.
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22 Click Plot.

23 Select the Plot Expression dialog box and click Close.

24 Click OK to close the Materials/Coefficients Library dialog box.

Including Properties in the Physics Settings of Models

Another way to access the Material Library is from the Subdomain Settings dialog boxes 
in the physics modes and in the optional COMSOL modules. If you do not have a 
geometry defined in the current model, define the simplest possible one, such as an 
arbitrary rectangle in 2D or a sphere in 3D, in order to follow this discussion. Then 
follow these steps:

1 From the Physics menu open the Subdomain Settings dialog box.

2 Click the Physics or Material tab depending on the application mode. This example 
uses the Subdomain Settings dialog box for the Conductive Media DC application 
mode.
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3 Select Ti-Ni (shape memory) from the Library material list.

Note that you have now selected the property for the electric conductivity that you 
defined earlier.

In case you want to load a new material from the Material Library without first editing 
it, you do not need to go to the Options menu. Instead, load it directly from the 
Subdomain Settings dialog box in this way:

1 In the Subdomain Settings dialog box click the Load button. This step opens the 
Materials/Coefficients Library in read-only mode. You can, for example, select the 
copper alloy UNS C15000, which is an excellent conductor.
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2 Select the Material Library>Al & Cu alloys>Copper alloys node and then select 
UNS C15000.

3 Click OK.

This replaces the Ti-Ni (shape memory) alloy with the properties of the copper alloy 
in the selected subdomain.
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As this example shows, the Conductive Media DC application mode has direct support 
for the Material Library. This means that once you have selected a material, the 
application mode automatically places the correct properties in the proper edit fields. 
Be aware, though, that this is not the case for all application modes. However, you can 
still manually access any property function from the materials that you have 
incorporated in a model by typing its function call in the desired edit field. For 
example, typing mat1_rho(T[1/K]) in any edit field calls the density function of the 
material that you first incorporated in the model, in this case Ti-Ni (shape memory), 
while mat2_rho(T[1/K]) calls the corresponding function for the second material, 
the copper alloy UNS C15000.
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TABLE 2-1:

MATERIA D IN 

SICS

Linear e

Instanta
expansio

Coeffici

Therma

Molar h

Heat ca

Dynami

Therma

Vapor p

Young’s 

Initial bu

Initial sh

Poisson

Electric 

Electric 

Surface 

Normal
Ma t e r i a l  P r op e r t i e s

COMSOL Multiphysics and its modules cover a wide range of disciplines in applied 
physics modeling, thus involving a large number of material properties. The user 
interfaces for different physics modeling, our so-called application modes, require 
more than 50 material properties. 

The Material Library contains 27 specific material properties, most of them directly 
supported in COMSOL Multiphysics. A property that is supported by an application 
mode is automatically incorporated in the proper edit field once you have selected a 
material. In the cases where a property is not supported by an application mode, you 
must manually enter a call to the property function. The properties available in the 
Material Library are:

  AVAILABLE MATERIAL PROPERTIES

L PROPERTY SHORT NAME ARGUMENT SI UNIT NUMBER OF 
MATERIALS 
WITH THIS 
PROPERTY

SUPPORTE
COMSOL 
MULTIPHY

xpansion dL Temperature - 1437

neous coefficient of thermal 
n

CTE Temperature 1/K 1047

ent of thermal expansion alpha Temperature 1/K 1439 √

l conductivity k Temperature W/(m·K) 990 √

eat capacity HC Temperature J/(mol·K) 380

pacity C Temperature J/(kg·K) 749 √

c viscosity eta Temperature Pa·s 95 √

l diffusivity TD Temperature m2/s 284

ressure VP Temperature Pa 99

modulus E Temperature Pa 898 √

lk modulus kappa Temperature Pa 350 √

ear modulus mu Temperature Pa 374 √

’s ratio nu Temperature - 374 √

resistivity res Temperature ohm·m 382 √

conductivity sigma Temperature S/m 382 √

emissivity epsilon Temperature - 76 √

 total emissivity nemiss Temperature - 50
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Tensile 

Yield st

Elongati

Density

Stress r

Creep s

Fatigue 

Relative

Nonline

Nonline

TABLE 2-1:

MATERIA ED IN 

SICS
* Fatigue data is supported through a script interface, see matlibfatigue on page 
188 in the Structural Mechanics Module Reference Guide.

The functions in the Material Library have the following default variables for the 
arguments:

You can change the default variable in the argument of the property functions to match 
variable names in a model. For example, if you use the variable T2 for temperature, 
change the argument of the property function from T to T2. Note that the argument 
need not be a modeled variable, it can also be a constant or an expression.

As mentioned earlier, the functions defining the material properties in the Material 
Library are based on the SI unit system. However, COMSOL Multiphysics’ built-in 

strength Syt Temperature Pa 540

rength level Sys Temperature Pa 480 √

on elong Temperature - 343

rho Temperature kg/m3 1822 √

upture SR Time Pa 147

trength CS Time Pa 43

S-N curve FSN Number of 
cycles

Pa 42 √*

 permeability mur Norm of H 
field

- 12 √

ar magnetic flux density, norm normfB Norm of H 
field

T 12 √

ar magnetic field, norm normfH Norm of B 
field

A/m 12 √

  AVAILABLE MATERIAL PROPERTIES

L PROPERTY SHORT NAME ARGUMENT SI UNIT NUMBER OF 
MATERIALS 
WITH THIS 
PROPERTY

SUPPORT
COMSOL 
MULTIPHY

ARGUMENT DEFAULT VARIABLE UNIT

Temperature T K

Time t h

Effective plastic strain epe -

Number of cycles n -

Norm of H field normH_emnc A/m

Norm of B field normB_emqa T
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unit conversion syntax allows you to use these properties for modeling in all base unit 
systems available in the software. For example, if you use T as variable name for 
temperature, the entry T[1/K] in the argument of a property function always gives the 
numeric temperature value expressed in kelvin as input to the property function, 
regardless of the current base unit system. If this property function is, say, a density, 
rho, you must also append the corresponding SI unit, kg/m3, so that the full, 
dimensionally correct expression reads rho(T[1/K])[kg/m^3].

In cases where property functions are not automatically supported in an application 
mode (see the rightmost column of Table 2-1), you must manually enter the material 
property function call. Here you prepend the string mati_ to the property’s short 
name from Table 2-1, where i  is the material number in the specific model. The 
materials are numbered according to the order of selection, which is identical with the 
order in which they appear in the Model node of the Materials list in the Materials/

Coefficients Library dialog box and the Library material list in the Subdomain Settings 
dialog box. For example, typing mat1_CTE(T[1/K]) in an edit field yields the 
instantaneous coefficient of thermal expansion for the material that you first added to 
the model.

Notes on the Material Properties

When using the Material Library, it is important to check the validity of the property 
function under the conditions that you are interested in investigating.

The following section contains remarks about the definition, error estimate, and 
conditions for some of the properties included in the Material Library. Note that every 
property function contains a literature reference where you can find more details about 
the conditions and validity range for that specific property (see “Reviewing Material 
Properties” on page 15).

Coefficient of Thermal Expansion   This coefficient is defined as (∆L/L)T/(T − Tref). 
In most cases this property is calculated from the ∆L/L values. The error is expected 
to be in the range of 10–15%, but it might be higher near room temperature due to 
the small value of T − Tref. 

Elastic and Initial Shear Modulus   The accuracy of this data is estimated to be 
approximately 5–10%. For solder alloys the literature reports a wide spread of values. 
Data from several sources (when available) are evaluated, and representative values are 
given; the error is estimated to be 10–25%. For some polymers the flexural modulus is 
used as the elastic modulus, and it is typically within 10% of the elastic modulus. 
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Typically, values measured with a strain gauge are approximately 10% lower than those 
measured with a dynamic technique. Values measured by a dynamic technique are 
preferred over those measured by strain gauge techniques. 

For cubic materials where the elastic and shear modulus are calculated from the elastic 
constants (C11, C12, C44), the Material Library uses the average of the Reuss and 
Voigt equations (see R.F.S. Hearmon, Advances in Physics, vol. 5, 1956, p. 232). For 
isotropic solids (glasses), it uses methods from L.D. Landau and E.M. Lifshitz, Theory 
of Elasticity, Addison-Wesley, New York, 1966.

Poisson's Ratio and Initial Bulk Modulus   These properties are calculated from the 
elastic modulus and the shear modulus using standard relationships, and in this sense 
they are self-consistent and accurate. The accuracy of this data is estimated to be 
approximately 10–20%. Because these are derived quantities, though, the error can be 
significantly higher. The curves for these properties often show improbable shapes that 
are most likely due to their derived nature and are not believed to be real. If the elastic 
and shear modulus were determined in a self-consistent manner, the curves would 
likely be much better behaved. However, all of the data are presented “as is” from the 
original references and are self-consistent within the Material Library. 

Thermal Conductivity   This property can be very sensitive to impurities, heat 
treatment, and mechanical worked state, especially at very low temperatures. This 
sensitivity is somewhat decreased above room temperature and decreases as the 
amount of alloying increases. Compare 4340-QT (quenched and tempered) and 
4340-NT (annealed).

Thermal Diffusivity   For metals this property can be very sensitive to impurities, heat 
treatment, and mechanical worked state, especially at very low temperatures. This 
sensitivity is somewhat decreased above room temperature and decreases as the 
amount of alloying increases. To see an example of this, compare the data for elemental 
(high purity) Fe and Armco iron (commercial purity). 

Electric Resistivity   This property is very sensitive to impurities, heat treatment, and 
mechanical worked state, especially at very low temperatures.

Electric Conductivity   This property is very sensitive to impurities, heat treatment, and 
mechanical worked state, especially at very low temperatures. 

Surface Emissivity (εT)   This property is the measured emissivity over all wavelengths 
and 2π radians. This is the emissivity used in the Stefan-Boltzmann law. 
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Normal Total Emissivity (εT,n)   The measured emissivity is over all wavelengths at a 
direction normal to the surface. This is the most commonly reported value. For 
polished metal the following assumption is valid: εT/εT,n = 1.15–1.20. Both 
emissivities are sensitive to the surface condition (roughness and oxide thickness). 

Density (ρ)   The density for solids is calculated from the room-temperature density 
and the linear expansion coefficient and is given by ρ/(1 + ∆L/L)3. The data for 
oxides, carbides, and nitrides depend on the material’s porosity. For gases the ideal gas 
law is used. 

Tensile Strength, Yield Strength Level, and Elongation   Most of the data for these 
properties are taken from product brochures provided by the material suppliers. Use 
these data with the understanding that they are only representative of the actual 
material properties. The variation with temperature is usually not smooth. Many of 
these materials are precipitation hardening alloys, and the temperature affects the 
aging processes in different ways at different temperatures. Unless otherwise stated, 
the data are for “short” times at the indicated temperatures and not for the equilibrium 
structure. These properties are very sensitive to the details of the processing and heat 
treatments. Comparison of data from different suppliers indicate that the spread in the 
published values is approximately 20% for materials with similar processing. The spread 
in the elongation data can be as high as 50–100%.

Fatigue S-N Curve   Fatigue data are given as the maximum stress, σmax, as function of 
the number of cycles. The stress amplitude, maximum stress, and minimum stress are 
related through the stress ratio, R.

The maximum stress, σmax, is given together with the stress ratio for all fatigue data. 
You can calculate the stress amplitude as

.

A script interface, see matlibfatigue on page 188 in the Structural Mechanics 
Module Reference Guide extracts S-N curves on the form σa, as function of the 
number of cycles. That is the definition required for fatigue analysis using the 
Structural Mechanics Module.

σa
σmax σmin–( )

2
-------------------------------------= R

σmax
σmin
-------------=

σa

σmax 1 1
R
----–⎝ ⎠

⎛ ⎞

2
---------------------------------=
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Creep Strength and Stress-Rupture Curves   This data is very sensitive to the test 
atmosphere as well as the microstructure and heat treatment of the material.

Polymers and Polymer-Based Composites   Properties of polymers and polymer-based 
composites are sensitive to moisture and processing conditions, and they can show 
time-dependence at higher temperatures. The errors/uncertainties can be large 
compared to those of other materials. Keep these aspects in mind when using the 
properties of these materials.

General   The magnitude of the errors reported by authors for a given property is 
usually smaller by a factor of 2–3 than the error between different sources for the same 
data. This is especially true for materials such as ceramics.
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M a t e r i a l  L i b r a r y  M o d e l i n g  E x a m p l e  
This chapter describes an example model of a MEMS device that uses the Material 
Library to include the temperature dependencies of the electric and thermal 
conductivities for the UNS C17500 alloy. A similar model, Thermal Expansion, 
which uses the Material Library to model thermal expansion, is available as part of 
the MEMS Module and the Structural Mechanics Module.
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J o u l e  Hea t i n g  i n  a  MEMS De v i c e  
U s i n g  t h e  Ma t e r i a l  L i b r a r y

Introduction

Joule heating is a common effect at the microscale, where current densities can be very 
high. This example model estimates the temperatures for a given set of voltages applied 
across a MEMS device. Such a device could be included in a microgyroscope or any 
other sensor that measures acceleration or position. The analysis also estimates the 
influence of temperature on the total current as a function of the voltage.

Model Definition

The model geometry appears in Figure 3-1.

Figure 3-1: Geometry of the MEMS device under study. The coordinate values are given 
in SI units. The largest dimension of the device is roughly 200 microns.

Surfaces attached
to a solid frame
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The model consists of two sets of physics:

• A thermal balance with a heat source in the device, originating from Joule heating 
(ohmic heating). Air cooling is applied on the boundaries except at the position 
where the device is attached to a solid frame, where an insulation condition is set.

• A current balance, where all boundaries are electrically insulated except the left and 
right surfaces attached to the solid frame. Over these surfaces a voltage is applied.

You solve the model using the applied voltage, U, as a parameter ranging between 
3 mV and 10 mV in steps of 1 mV.

The device is made of the copper-beryllium alloy UNS C17500.

The thermal balance consists of a balance of flux at steady state. The heat flux is given 
by conduction only. The heat originates from the ohmic losses and is proportional to 
the square of the modulus of the electric field and the electric conductivity. The air 
cooling at the boundaries is expressed using a constant heat transfer coefficient of 
10 W/m2 and an ambient temperature of 298 K (25 °C). The electric-current density 
is given by Ohm’s law, where that density is set to the conductivity times the electric 
field. A voltage of 3 mV is applied across the left and right surfaces attached to the solid 
frame.

Both the thermal and electric conductivities are temperature dependent, which means 
that the electric potential and temperature fields must be solved fully coupled.

The Material Library makes it possible to review the dependencies of the electric and 
thermal conductivities on temperature for UNS C17500. You can see from the 
corresponding graphs that the property functions are defined for a wide temperature 
interval, from 300 K to 1100 K. It is important that you always check the validity of 
property functions for the conditions in your specific process.

Figure 3-2: Thermal conductivity (left) and electric conductivity (right) for UNS 
C17500.
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Results and Discussion

The following figure shows the temperature distribution in the device for an applied 
voltage of 3 mV. The heat source increases the temperature from an ambient 
temperature of 298 K to 378 K, which is well within the temperature range for the 
property functions. The temperature is almost constant inside the device.

Figure 3-3: Temperature distribution in the device.

Figure 3-4 shows the modulus of the current-density vector. As expected, current 
density is largest in the device’s inner sharp corners. A possible improvement of the 
model would be to round these corners to their true physical curvature. The inner 
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surfaces of the U-shaped bends also display a high current density because the current 
takes a shorter path through the device.

Figure 3-4: The modulus of the current-density vector, [A/m2].

An interesting issue is the influence of temperature on the linearity of the current 
density as a function of the total potential difference across the device. The next graphs 
show total current and temperature as functions of the applied voltage, respectively.

Figure 3-5: Total current through the device (left) and inner temperature (right) as 
functions of the applied voltage.
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Model Library path:  
COMSOL_Multiphysics/Multiphysics/mems_joule_heating

Modeling Using the Graphical User Interface

1 Open the Model Navigator.

2 Select 3D from the Space dimension list.

3 In the list of application modes select COMSOL Multiphysics> 
Electro-Thermal Interactions>Joule Heating>Steady-state analysis.

4 Click OK.

G E O M E T R Y  M O D E L I N G

1 From the Draw menu select Work Plane Settings.

2 Click the x-y button in the Plane area if it is not already selected. Click OK.

3 From the Options menu select Axes/Grid Settings.

4 Enter -1.3e-4 in the x min edit field, 1.3e-4 in the x max edit field, -0.3e-4 in 
the y min edit field, and 1.3e-4 in the y max edit field.

5 Click the Grid tab, then clear the Auto check box.
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6 Enter 1e-5 in both the x spacing and y spacing edit fields.

7 Click OK.

Next draw a projection of the 3D geometry and extrude it to create a 3D object:

1 From the Draw menu select Specify Objects>Rectangle.

2 In the Size area, type 1e-5 in the Width edit field and 8e-5 in the Height edit field.

3 In the Position area, type -1e-4 in the x edit field. Click OK.

4 Click the 2nd Degree Bézier Curve button on the Draw toolbar to the left in the user 
interface. Click the coordinates (-9e-5, 8e-5), (-9e-5, 9e-5), and (-8e-5, 9e-5) to 
create an arc.

5 Click the Line button on the Draw toolbar, then click the coordinate (-8e-5, 1e-4).

6 Click the 2nd Degree Bézier Curve button on the Draw toolbar, then click the 
coordinates (-1e-4, 1e-4) and (-1e-4, 8e-5).

7 Click the right mouse button to form a composite object with the shape of an elbow.

8 Press Ctrl+A to select both objects.

9 Click the Mirror button on the Draw toolbar.
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10 In the Mirror dialog box locate the Point on line row. In the cell under the x column 
enter -8e-5. Make sure that the Normal vector row has the default values x = 1 and 
y = 0. Click OK.

11 Press Ctrl+A to select all the objects and Ctrl+C to copy them. 

12 Press Ctrl+V to paste the objects. In the resulting Paste dialog box enter 5e-5 in the 
x edit field. Click OK.

13 Press Ctrl+A to select all the objects and Ctrl+C to copy them.
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14 Press Ctrl+V to paste all objects. In the resulting Paste dialog box enter 1e-4 in the 
x edit field. Click OK.

15 Click the Zoom Extents button on the Main toolbar at the top of the user interface.

16 From the Draw menu select Specify Objects>Rectangle.

17 In the Width edit field enter 3e-5; in the Height edit field enter 1e-5; and in the x 
edit field enter -7e-5. Click OK.

18 Press Ctrl+C followed by Ctrl+V to copy and paste the selected rectangle.

19 In the Paste dialog box type 5e-5 in the x edit field. Click OK.

20 Press Ctrl+C followed by Ctrl+V to copy and paste the selected rectangle.

21 In the Paste dialog box type 5e-5 in the x edit field. Click OK.
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22 Press Ctrl+A and then click the Union button on the Draw toolbar to create one 
composite object.

23 From the Draw menu select Extrude.

24 Enter 1e-5 in the Distance edit field. Click OK.
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25 Click the Headlight button on the Camera toolbar.

P H Y S I C S  S E T T I N G S

First define a variable for the total electric current through the device.

Boundary Coupling Variables
1 Choose Options>Integration Coupling Variables>Boundary Variables.

2 Select Boundary 5.

3 In the first row of the table, type I in the Name column and nJ_dc in the Expression 
column. Leave the default settings for Integration order and Global destination.

4 Click OK.

Proceed by setting the subdomain properties and boundary conditions, starting with 
the thermal analysis.

Subdomain Settings—Heat Transfer by Conduction
1 From the Multiphysics menu select Heat Transfer by Conduction (ht).

2 From the Physics menu select Subdomain Settings.

3 Click the Subdomain selection list and press Ctrl+A to select all the subdomains.

4 Click the Load button.
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5 In the Materials list select Material Library>Al & Cu alloys>Copper alloys>UNS C17500.

6 Click OK.

7 Click OK to close the Subdomain Settings dialog box.

Boundary Conditions—Heat Transfer by Conduction
1 From the Physics menu select Boundary Settings.

2 Click the Boundary selection list.
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3 Press Ctrl+A to select all the boundaries.

4 In the Boundary selection list, press Ctrl and then click Boundaries 2, 17, 26, 32, 52, 
61, 67, 87, 96, 102, and 122 to clear them from the current selection. 

Note that you can also do this directly in the user interface by selecting all the 
boundaries, clicking the right mouse button to keep the selection, and then 
selecting the boundaries corresponding to the attachment to the base one at the 
time. When you click on a boundary, it turns green. If this is the boundary you want 
to clear from the selection list, click the right mouse button. Repeat this procedure 
until all boundaries just listed are cleared from the selection.

5 From the Boundary condition list select Heat flux.

6 Enter 10 in the Heat transfer coefficient edit field and 298 in the External temperature 
edit field.

7 Click OK.

Subdomain Settings—Conductive Media DC
1 From the Multiphysics menu select the Conductive Media DC (dc) application mode.

2 From the Physics menu select Subdomain Settings.

3 Select all the subdomains in the Subdomain selection list, if they are not already 
selected.

4 Click the σ (isotropic) button.

5 In the Library material list select UNS C17500.

6 Click OK.

Boundary Settings—Conductive Media DC
1 From the Physics menu select the Boundary Settings.

2 Click the Boundary selection list, then press Ctrl+A to select all the boundaries.

3 From the Boundary condition list select Electric insulation.

4 Select Boundary 2, then select Ground from the Boundary condition list.

5 Select Boundary 122, then select Electric potential from the Boundary condition list.

6 In the V0 edit field type U.

7 Click OK.

M E S H  G E N E R A T I O N

1 Click the Interactive Meshing button on the Mesh toolbar.

2 Select Boundary 2, which is the left-most boundary attached to the solid frame.
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3 Click the Decrease Mesh Size button on the Mesh toolbar to decrease the mesh size 
from normal to fine.

4 Click the Decrease Mesh Size button on the Mesh toolbar a second and a third time 
to decrease the mesh size to extra fine.

5 Click the Mesh Selected (Mapped) button on the Mesh toolbar.

6 Click the Subdomain Mode button on the Main toolbar.

7 Select Subdomains 1–5, which are the five first domains from left to right. Note that 
you can do this by clicking the mouse until you get the desired subdomain 
highlighted, then right-click to save that selection. Continue to the next subdomain, 
highlight it by clicking on it, and right-click to save that selection. Repeat this 
process until you have selected all five subdomains. Alternatively, you can open the 
Subdomain Settings dialog box and do the selection in the Subdomain selection list 
before clicking Cancel to close the dialog box.

8 Click the Mesh Selected (Swept) button on the Mesh toolbar.

There is a good reason for not sweeping the mesh throughout all subdomains: the 
meshing of the cubic sections, which unite the U-shaped sections of the geometry, 
requires that you change the sweep direction in order to create only hexagonal mesh 
elements. If you instead mesh all U-shaped sections first, COMSOL Multiphysics 
detects the sweep dimension automatically by the fact that two opposite faces of the 
cubes are meshed. You can therefore first create a swept mesh for all U-shaped 
sections and then mesh the cubes to create a hexagonal mesh for the entire 
geometry.

9 Click the Boundary Mode button on the Main toolbar.

10 Select Boundaries 32, 67, and 102. The easiest way to locate these boundaries is by 
doing the selection in the Boundary selection list in the Boundary Settings dialog box. 
Alternatively, you can use the technique outlined earlier—that is, click on the 
desired boundary until it gets highlighted, then right-click to save the selection, and 
so on for multiple selections.

11 Click the Mesh Selected (Mapped) button on the Mesh toolbar.

12 Click the Subdomain Mode button on the Main toolbar.

13 Press Ctrl+D to clear the current selection.

14 Select Subdomains 7–12, 14–19, and 21–25 by using the one of the techniques 
outlined in Step 7.

15 Click the Mesh Selected (Swept) button.

16 Select Subdomains 6, 13, and 20.
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17 Click the Mesh Selected (Swept) button.

C O M P U T I N G  T H E  S O L U T I O N

1 Click the Solver Parameters button on the Main toolbar to open the Solver 

Parameters dialog box.

2 From the Solver list select Parametric.

3 In the Parameter area, type U in the Parameter name edit field and type 
3e-3:1e-3:10e-3 in the Parameter values edit field. When solving the model this 
gives solutions for applied voltages of 3 mV, 4 mV, …, 10 mV.

4 From the Linear system solver list select Direct (UMFPACK).

5 Click OK to close the Solver Parameters dialog box.

6 Click the Solve button on the Main toolbar. Note that the solution is fully coupled.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

To reproduce the plot in Figure 3-3, displaying the surface temperature distribution 
for an applied voltage of 3 mV, perform the following steps:

1 Click the Plot Parameters button on the Main toolbar.

2 On the General page, clear the Slice check box and select the Boundary check box.
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3 In the Solution to use area, select 0.003 from the Parameter value list.

4 Click the Boundary tab.

5 Enter T in the Expression edit field.

6 Click OK to generate the plot.

Finally, generate the plots in Figure 3-5 of the total current and the temperature as 
functions of the applied voltage by following these steps:

1 From the Postprocessing menu select Cross-Section Plot Parameters.

2 Click the Point tab. In the Expression edit field type I.

3 Click the General tab. Click the Title/Axis button.

4 Click the option button next to the Title edit field. Leave the edit field empty to 
obtain a plot without a title.

5 Click the option button next to the First axis label edit field, then enter the label 
Voltage [V].

6 Click the option button next to the Second axis label edit field, then enter the label 
Current [A].

7 Click OK to close the Title/Axis Settings dialog box, then click Apply to generate the 
left plot in Figure 3-5.

8 Click the Point tab. In the Expression edit field type T.

9 In the Coordinates area, enter the x, y, and z values, -5e-6, 5e-6, and 5e-6, 
respectively. 

These settings correspond to a point in the center of the central cubic subdomain 
(number 13). Because the temperature distribution is essentially uniform, the 
choice of point inside the device is arbitrary.

10 Return to the General page. From the Plot in list select New figure.

11 Click the Title/Axis button.

12 Click the Auto option button for the Second axis label, then click OK.

13 Click OK to close the Cross-Section Plot Parameters dialog box and generate the right 
plot in Figure 3-5.
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 4
F u n c t i o n s
The Material Library describes material properties with functions, usually 
functions of temperature, and for this purpose it uses piecewise analytic functions. 
For user-defined property functions you can define three types of functions—inline, 
piecewise analytic, or interpolation.

This chapter details the Functions feature that describes the material properties in 
the Material Library and the functions that you can use to define custom properties.
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U s i n g  I n l i n e  Fun c t i o n s

Just as you can define variables in COMSOL Multiphysics, you can define inline 
functions. They extend variables with the ability to bind parameters during function 
calls. In other words, you do not need to know the actual names of the variables in an 
expression when you write the function. You define inline functions in the Functions 
dialog box.

Assume that you want to define Young’s modulus for a material as a function of 
pressure and temperature. You can name the function young(p,T) and use the 
expression 2e10+1e6*p-1e8*T to define the function. Follow these steps:

1 From the Options menu open the Materials/Coefficients Library dialog box. 

2 Click the + sign in the Material Library node in the Materials list to expand the 
Material Library node.

3 Click the + sign in the Cast Irons & Mold materials node.

4 Click the + sign in the Cast Irons node.

5 Select material A297 HI (UNS J94003) in the Cast Irons node. Note that this material 
entry does not contain the Young’s modulus.

6 Click the Copy button.

7 Click the Model node in the Materials tree, then click Paste to add this material to 
those available inside the model.

8 Click the Functions button.

9 Click the New button.

10 In the New Function dialog box that appears, select Analytic and type young in the 
Function name edit field. Click OK to return to the Functions dialog box.

11 In the Arguments edit field type p,T.

12 In the Expression edit field type 2e10+1e6*p-1e8*T.
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13 Click the Manual button in the Derivatives area, then type 
1e6,-1e8 in the associated edit field.

14 Click OK.

15 The function young can now be used to define the Young’s modulus in your 
material.

16 Enter  young(p[1/Pa],T[1/K])[Pa] in the Value/Expression column in the 
Young’s modulus row.

17 Click OK to close the Materials/Coefficients Library dialog box.

COMSOL Multiphysics must know the derivative of a function if you are using a 
variable that depends on the solution in a function argument. This is the reason in the 
previous exercise for clicking the Manual button and entering the derivatives in the 
associated edit field. Note that you can use of the diff operator to compute derivatives 
of a function (see “Using Special Operators” on page 155 in the COMSOL 
Multiphysics User’s Guide for more information). If you click the Auto button in the 
Derivatives area, COMSOL Multiphysics uses the diff operator on the expression to 
get the derivatives. Select the May produce complex output for real arguments check box 
if the defined function works similarly to sqrt, that is, if it sometimes returns complex 
values for a real-valued input.
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U s i n g  Fun c t i o n s  Ba s e d  on 
I n t e r po l a t e d  Da t a

To define functions based on interpolated data, use the Functions dialog box, which 
you open through the Functions button in the Materials/Coefficients Library dialog box. 
To define a new interpolation function, click the New button to open the New Function 
dialog box. Specify a name for the function, then click the Interpolation button. Next 
choose a method for entering data and, if applicable, a data source, then click OK.

Figure 4-1: The Functions dialog box, used here to edit an interpolation function.

For functions of one variable, you can choose between the following interpolation 
methods:

• Nearest neighbor

• Linear

• Piecewise cubic

• Cubic spline

For functions of more than one variable, COMSOL Multiphysics supports only the 
nearest-neighbor and linear interpolation methods. 
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Piecewise-cubic interpolation is a method using a piecewise-cubic Hermite polynomial 
with continuous first derivatives. It preserves the shape of the data and respects 
monotonicity. The cubic-spline method also performs interpolation with a piecewise 
cubic polynomial. Here even second derivatives are continuous; however, the method 
does not necessarily respect monotonicity.

You must also specify how COMSOL Multiphysics treats arguments that fall outside 
the grid. There are three extrapolation methods to choose from:

• Constant

• Interpolation function

• Specific number

Constant means that the extrapolation method uses the value from the closest point 
inside the grid, while Interpolation Function evaluates the polynomial from the closest 
grid point at the actual point where a value is requested. If selecting Specific Number, 
you can assign a single value, usually zero or NaN, to all points outside the grid.

For functions of one variable you can enter the data directly into a lookup table. In this 
case you can get a preview of the function by clicking the Plot button. 

For functions of one to three variables, you can either retrieve data from a text file, 
COMSOL Script, or MATLAB. The file format is the same as that for a file produced 
when exporting in the format Grid, data on a regular grid using the selection 
Export>Postprocessing Data from the File menu:

% Grid
x grid points separated by spaces
y grid points separated by spaces (optional)
z grid points separated by spaces (optional)
% Data
Data values separated by spaces

Each row contains values for different x grid points for fixed values of  y and z. The 
rows first increase the  y grid value and then the z grid value. The grid points can also 
represent another independent variable that the data values depend on. For example, 
the “grid points” can be temperature values and the data values can represent the 
thermal conductivity at these temperatures (see the example in “Interpolation of 
Measured Data and Nonlinear Materials” on page 219 in the COMSOL Multiphysics 
User’s Guide). It is important to use a comment line starting with % to separate the 
grid points or other interpolation points and the data values that are associated with 
these coordinates or interpolation points.
U S I N G  F U N C T I O N S  B A S E D  O N  I N T E R P O L A T E D  D A T A  |  55



56 |  C H A P T E R
To retrieve data from COMSOL Script or MATLAB, create a structure on the 
command line with the fields x, y (optional), z (optional), and data. Then x, y, and z 
are vectors specifying the grid, and data is a multidimensional array of the same format 
as produced by the function call [xx,yy,zz] = meshgrid(x,y,z);. For example, to 
define the function f (x, y, z) = x y sin( z) on a unit-cube grid and prepare it for export to 
COMSOL Multiphysics, type the following on the COMSOL Script or MATLAB 
command line:

x = linspace(0,1,11); y = linspace(0,1,11); z = linspace(0,1,11);
[xx,yy,zz] = meshgrid(x,y,z);
data = xx.*yy.*sin(zz);
f.x = x; f.y = y; f.z = z; f.data = data;

When COMSOL Multiphysics evaluates the function, the software performs a 
structured interpolation from the data values on the grid to the coordinates where the 
function is evaluated. See “A Rock Fracture Flow Model” on page 250 in the 
COMSOL Multiphysics Model Library for an example using data interpolation.

COMSOL Multiphysics stores the data it retrieves from COMSOL Script or MATLAB 
in the function when it is created, and the connection to the original structure is lost. 
When the data is stored in a text file, the function stores only the name of the text file 
and reads data from the file during the analysis.
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U s i n g  P i e c ew i s e  Ana l y t i c  F un c t i o n s

To define your own piecewise analytic functions, use the Functions dialog box, which 
you open through the Functions button in the Materials/Coefficients Library dialog box. 

To define a new piecewise analytic function, click the New button to open the New 

Function dialog box. Specify a name for the function in the Function name edit field, 
then click the Piecewise analytic option button and finally click OK.

Figure 4-2: The Functions dialog box, used here to edit a piecewise analytic function 
defining the Young’s modulus for the material 1010 (G10100) in the Material Library.

You can choose between three different function types in the Function type list: 

• Polynomial

•  Exponential polynomial

•  General

PO L Y N O M I A L

Use the Polynomial function type to define functions using different polynomials on 
the intervals, that is

f x( ) aij

i
∑ xi

= xjstart x xjend≤<
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where  i can be any integer.

E X P O N E N T I A L  P O L Y N O M I A L

Use the Exponential polynomial function type to define functions using different 
exponential functions with a polynomial exponent on the intervals, that is

where i can be any nonnegative integer.

G E N E R A L

Use the General function type to create functions that use an analytic expression on 
the different intervals. For the General type you must also specify a name in the 
Argument edit field.

It is also necessary to specify how COMSOL Multiphysics treats arguments that fall 
outside the intervals. There are four extrapolation methods to choose from in the 
Extrapolation method list:

• No extrapolation

The function is not defined outside the interval. Trying to evaluate the function 
generates an error and evaluates to NaN.

• Constant (default)

The extrapolation method uses the value from the start point of the first interval and 
the end point of the last interval on the corresponding sides.

• Nearest function

The function at the first or last interval (depending of the side) is used to evaluate 
at the actual point where a value is requested.

• Specific number

If selecting the Specific Number method you can assign a single value (usually zero 
or NaN) to all points outside the intervals. Enter the single value in the Value outside 

range edit field.

Functions defined in the different intervals can create a discontinuous function, which 
can cause problems for the solvers. One way to avoid this is to smooth the function at 
the interval borders. You choose among four levels in the Smoothing list:

• No smoothing (default)

f x( ) e

aij

i

∑ xi

= xjstart x xjend≤<
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• Continuous function

• Continuous first derivative

• Continuous second derivative

You specify the size of the smoothing zone in the Relative size of smoothing zone edit 
field. “Relative size” here means in relation to the size of the intervals on both sides of 
the border.

Select the May produce complex output for real arguments check box if the defined 
function works similarly to sqrt; that is, it sometimes returns complex values for a 
real-valued input.

You enter the start and end points together with the definition of the function on the 
interval directly into a table. The table has three columns:

•  xstart

•  xend

•  f(x)

Specify the interval limits in the xstart and xend columns. 

Note: The intervals must be contiguous and in ascending order.

Specify the function definition in the f(x) column. You define the function differently 
depending of the Function type. The Polynomial and Exponential polynomial function 
types are defined using consecutive pairs specifying the polynomial order and the 
corresponding coefficient. For example, to specify the function

enter 0 1.23 3 1.2e3 5 -6.58 in the f(x) column. You specify a General function 
by simply entering the expression using the argument you have specified in the 
Argument edit field. Enter the above function as 1.23+1.2e3*x^3-6.58*x^5 if you 
specify x as the argument.

You get a preview of a function by clicking the Plot button.

f x( ) 1.23 1.2·103x3 6.58x5
–+=
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